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Introduction 
 
Reports aggregate and display data in a readable format to help the agency manage their business.  
Reports can assist with the daily workflow, provide information about monthly and yearly earnings, and 
help locate clients for specific marketing campaigns.  There are several reports created by FSC that can 
be run from the Reports button on the Banner.  Users may also use Report Builder to create their own 
custom reports.  
 
This chapter will explain what kind of information each report contains and includes instructions on setting 
up custom reports. 

Reports Training 

Reports Screen 

The Reports button opens this screen.  The standard or canned reports are listed in the Reports area at 
the bottom of the screen.  Reports are grouped together in categories to help users better understand 
their functionality.   
 

 

Figure 1: Reports 

 
 
 
Click on the + to expand the category and see the list of available reports. The report categories and 
names cannot be changed in this area.  The user must view a report parameters screen each time a  
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report is run to verify that the date range is correct and to select any filter, sort, or page break options 
before printing. 

Report Parameters 

 

 

Figure 2: Report Parameters Screen 

 

Many reports incorporate a date filter.  Any report with a date filter will have two options: Relative date 
and Custom date.  Relative dates allow the user to select a period of time (i.e. this month) and then the 
report calculates the correct date range.  The user can also select a Custom date and specify the 
beginning and end of the date range.  
 
 
By default, the filter drop downs will only show active items.  It is rare that a user would need to filter by 
an inactive producer, company, sub-agency, or category, and it causes confusion when duplicate items 
(active and inactive) appear in a drop down filter.  However, if this is necessary, click on the Options 
menu and click on Show “inactive” items in filters.  This will adjust the drop downs to include inactive 
items. 
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Custom Filters 

Many filters contain an option called <Custom>.  When the user selects <Custom>, a selection screen will 
open, the user can check mark in the options that apply and click OK.  If there is a custom filter that is 
used repeatedly, follow the steps below to create a saved group for that filter. 

1. At the main report screen, go to Tools->Setup Saved Groups 

 

 

Figure 3: Reports – Tools->Setup Saved Groups 

 

2. Select a group type from the drop down 

 

 

Figure 4: Select a Group 

 

3. Click + to add a custom group 
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Figure 5: Select Multiple Records for Group 

4. Check mark the group members 

5. Give the group a name 

6. Click OK to save and click X to exit. 

The custom group will appear in the filter drop down of all applicable reports. 

 

Figure 6: Saved Group Appears in Filter Drop Down 
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My Reports Screen 

The top area of Reports, referred to as My Reports throughout this document, can be customized by each 
user in the following ways: 

» Create a custom list of reports that the user commonly uses  

» Rename the reports 

» Organize the reports by categories 

» Create multiple instances of the same report but with different dates, filters, sort and page break 
options 

The date range, filters, sort and page break options are automatically saved when a report is run from My 
Reports. 
 
Reports can be added to My Reports by clicking, dragging and dropping, or by right-clicking and selecting 
Add to My Reports.  
 

 

Figure 3: My Reports 

 

 Once the report has been moved to My Reports, users can do the following: 

» Drag and drop reports into categories 

» Drag and drop reports to move them up and down the list 

» Run the report   (double click) 

 

» Preview the report  
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» Print the report   

» View the report data in Excel   

» View the report in PDF   

» Email Report   (this can only be done within the report) 

» Right-click on report and set frequency 

» Right-click on a report and copy (giving a new name) 

» Right-click on report and rename 

» Right-click on a report and remove from My Reports 

» Right-click on category and rename 

» Right-click and create new category 

» Right-click and delete category 

Report Hyperlinks 

Reports contain hyperlinks that allow users to navigate directly to information on the report from the report 
preview.  Hyperlinks are identified in blue with an underline (e.g.  Client name will open a Client screen). 

Many reports will also contain an Open Clients button  at the report filter screen.  After determining 
the report criteria, the user may click on this button to load all client screens for everyone that would 
appear on the report.  The user may then scroll from one client to the next. 

On the Download Transaction Report the user can double click a policy listed on the grid to open 
an individual client or policy.  The default will open the policy, but the user can change the default 
by right clicking on the grid and putting a check mark in Client Opens with Double Click. 

Reports Summary 

Below is a list of all reports along with a brief description.   

Accounting   

Accounting Transaction – Detailed - A breakdown of the Accounting Transaction Summary report.  View 
the detail of all debits and credits for a general ledger account number in a given date range. 

Accounting Transaction Summary - Recreates the Transaction Report generated by posting transactions 
to Peachtree/Quickbooks.  This report can be used to compare the journal entries in FSC Manager with 
Peachtree/Quickbooks if the user believes there is a discrepancy. 

Accounts Receivable History - The history of an individual client’s accounts receivable.  This is similar to a 
statement; however, unlike a statement, it includes history invoices. 

Accounts Receivable Summary - This is a summary of all aged accounts receivable, as of the day the 
report is run.  This report cannot be run for a previous date, so it is important to print and save a copy of 
the report on the last day of the month and the last day of the year.  The amount showing in the Balance  
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Due column should equal the total of the 1100 (Accounts Receivable)+/- 1180 (Pre-Paid on Account) in 
Peachtree/Quickbooks. 

Checks to Issue – Refund/Premium Finance - A list of checks that need to be issued in the accounting 
software due to refunds and premium finance endorsements completed in FSC Manager.  When issuing 
these checks, the user should debit cash and credit the 2060 (Checks to Issue) account. 

Checks to Issue – Simple Receipts - A list of money that needs to be paid to a carrier on a direct bill 
policy because the insured made the payment at the agency.  This report is generated from Simple 
Receipts. 

Deleted Simple Receipts - A list of payments made in the office on direct bill policies that were deleted 
because they were duplicate entries, entered on the wrong client, or returned due to insufficient funds.  
This information comes from the Simple Receipt button in Clients. 

Direct Bill Invoice History - The history of an individual client’s direct bill invoices.  This information comes 
from invoices on the Direct Invoices tab in Billing Setup. 

Receipts – Agency Bill - A list of agency bill payments that can be used to fill out a deposit slip.   
Information comes from Receipts button on the Banner. 

Simple Receipts - A list of payments made at the agency on direct bill policies.  The report is broken down 
by type of payment: Cash, Check, Money Order, Credit Card, and Debit Card.  Information comes from 
the Simple Receipts button in Clients. 

Voided Receipts – Agency Bill - A list of receipts from agency bill policies that were voided because they 
were duplicate entries, entered on the wrong client, or returned due to insufficient funds.  This information 
comes from the Receipts area on the Banner. 

 

Download   

Download Error/Info Log - A list of policies that had errors during the download process.   This report can 
also be accessed immediately after the download or by going to Tasks and executing View Company 
Download Information ->View Error/Info Log. 

Download Transactions - A list of all policies downloaded for a date range.  This report can be accessed 
immediately after the download or by going to Tasks and executing View Company Download Information 
->View Transaction Log.  The user can use the Open Clients button at the top to open all clients 
simultaneously from the report.  The user can also double click on a policy in the grid to opne an 
individual client or policy depending on the setting.  (The default opens the policy, but the user may 
change the default by right clicking on the grid and putting a check mark in Client Opens with Double 
Click.) 

Premium Change - A report of policies that have had a premium change during the download process.  
Most agencies use this report to identify renewals that have increased by more than a specified percent 
so they can re-quote the policy before the insured decides to shop for new insurance.  The user 
determines the percent of increase and how many days they would like to look back through the 
download. 

 

Management   

Address Book List - A report of Address Book information.  Contact information is optional. 
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Client List - A report of client name, address, phone numbers and email address.  Easily exported to 
Excel for mass mailings. 

Client Rank - A list of active clients and the total annualized premium and commission generated by their 
active policies.  The report is ranked from highest to lowest based on either premium or commission.   

Company List - A report of Companies from the System area.  Contact information is optional. 

General Agency List - A report of General Agencies from the System area.  Contact information is 
optional. 

Policy List - A master list of all active policies with a particular company or all companies. 

Service Link Inquiries - A report on the number of Service Link (Real-Time) inquiries completed in FSC 

Manager.   

Tranlog Summary - A summary of the number Tranlogs done in a date range broken down by category.  
This report can also grouped by user to see how many Tranlogs individual users are doing in a specified 
date range. 

Tranlogs - A report of all Tranlogs made in the system during a given date range. 

 

Marketing   

Auto And Home Not Umbrella - This report searches the database for clients that have an auto and a 
home policy but do not have an umbrella. 

Auto Not Home - This report searches the database for clients that have an auto policy, but do not have a 
home policy. 

Business Classification - Allows agencies to find clients that are classified as a specific type of business.  
Agencies can assign the type of business on the Client screen under More Info.  This is useful if a carrier 
has a specialty market for a specific type of business (i.e. a special program for Plumbers). 

Cross Selling Policy Types - This report allows the user to search the database for cross selling 
opportunities. 

Family Member Ages - A report of family members who fall within a specified age range.  Often used for 
marketing products that may target clients of a specific age (i.e. supplemental health care insurance to 
individuals over 64 years of age). 

Family Member Birthdates - A report of family members who have a birthday in a given month.  Agencies 
use this report to send birthday cards to insured’s and their family members. 

Home Not Auto - This report searches the database for clients that have a home policy, but do not have 
an auto policy. 

Lead Classification - Allows agencies to track how new customers are hearing about the agency.  This 
information comes from the Lead field on the Client screen on the More Info tab. 

Prospect Expiration Dates - Expiration list of policies on Prospects (Prospects are defined as records 
added to the Client button on the Banner and assigned a status of Prospect).  This report searches on the 
month of the expiration date, not year. 

Prospect List - A report of prospect name, address, phone numbers and email address.  Prospects are 
defined as records added to the Client button on the Banner and assigned a status of Prospect. 
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Policy Maintenance   

Claim Payments - Claim payment history on a specific client.  This information comes from the Claim 
Payment tab of the four loss notices in the system:  Auto Loss, Property Loss, Notice of Occurrence and 
First Report of Injury or Illness. 

Claims - A list of open and/or closed claims for a given period of time.  This information comes from the 
four loss notices in the system: Auto Loss, Property Loss, Notice of Occurrence and First Report of Injury 
or Illness. 

Expiration List - A list of policies due to expire in a given month.  The option “Show Renewed Policies” 
allows the report to find policies that were due to expire in the requested month, but have already been 
renewed.  These policies will be designated with a (R) after their expiration date. 

Expired Policies - Policies where the expiration date has passed but the policy is still listed as active.    
Research whether the policy should be renewed or cancelled. 

Pending Applications - A list of policies that have Pending or Future Application in the policy number that 
are marked as active.  If the policy has not been written, change the status to inactive or quoted.  This 
helps keep the system clean when running other reports and doing marketing. 

Personal Auto Limits - A list of all policies that have specified auto limits/deductibles. 

 

Production   

Agency Commissions - A report of agency commissions per company.  This information is generated by 
users creating invoices in Billing Setup.  Should the agency choose to reconcile the commissions, this is 
done from the Comm button on the Banner. 

Agency Bill commissions will be handled in Billing Setup/Commission Reconciliation.  Direct Bill 
commissions can be handled in the Billing Setup/Commission Reconciliation if the agency wishes to 
reconcile commissions.  If the agency does not wish to reconcile, it may be easier and quicker to use the 
new DB Comm area.  Several carriers can download commission statements to the DB Comm area or the 
agency may manually enter the commissions.  There is a separate agency commission statement for the 
DB Comm area. 

Agency Fees - Agency fees assigned on a Simple Receipt during a given period of time. 

Annualized Premium Projection - An estimate of the agency’s book of business if all premiums and 
commissions are annualized.  The information is broken down by line of business and shows a 
percentage of total premium volume for each line of business.  This is useful when filling out an 
application for E & O insurance. 

Report Basis Options: 

Invoice Commissions -  All invoices that were invoiced during the date range (uses Invoice Date)   

Reconciled Commissions – All invoices that have been reconciled and assigned a Paid Date in 
the range requested (uses Paid Date). 

Book of Business – Shows premium and commission earned for each line of business for the month and 
then year-to-date.  This comes directly from the direct and agency bill invoices created in Billing Setup.  
This report is generally printed at the end of each month. 

Cancelled Policies - Track the number of cancelled policies during a given time period and the amount of 
premium that is lost. This report will include policies that were re-written because the original policy will be 
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“cancelled” by the initial carrier.  This report tracks cancellations based on policy status being cancelled 
and the cancellation date. 

New Business - Tracks the number of new policies written during a given time period and the amount of 
premium that is gained.  This report will include policies that were re-written because the policy that is 
written with the new carrier will be considered “new”.  This report identifies new business by its issue date, 
which is visible from the Billing Setup area. 

Policy Demographics by Region - A breakdown of policy count and annual premium by location (zip, city, 
state or county). 

Producer Broker Fees - A report of fees paid to the agency that have been split with the producer.  This 
information is generated from commissionable fees added to Simple Receipts. 

Producer Commissions - A report of producer commissions with a page break between producers.  This 
information is generated by users creating invoices in Billing Setup.  Should the agency choose to 
reconcile the commissions, this is done from the Comm button on the Banner. 

Report Basis Options: 

Invoice Commissions -  All invoices that were invoiced during the date range (uses Invoice Date)   

Reconciled Commissions, Unpaid – All invoices that have been reconciled and assigned a Paid 
Date in the range requested, but do not have a Paid Agent Date (uses Paid Date) 

Reconciled  Commissions, Paid – All invoices that have been reconciled and assigned both a 
Paid Date and a Paid Agent Date (uses the Paid Agent Date) 

Agency Bill commissions will be handled in Billing Setup/Commission Reconciliation.  Direct Bill 
commissions can be handled in the Billing Setup/Commission Reconciliation if the agency wishes to 
reconcile commissions.  If the agency does not wish to reconcile, it may be easier and quicker to use the 
new DB Comm area.  Several carriers can download commission statements to the DB Comm area or the 
agency may manually enter the commissions.  There is a separate producer commission statement for 
the DB Comm area. 

How to Create a New Custom Report 

As an example, we will create a report called Premium Volume by Client.  This will show us the total of 
annualized premium and commission for each active client and for their active policies. 

 

 

1. Click the Reports button on the banner. 

2. Click Create New Custom Report button . 

3. Select the Table where the data to be reported on is stored.  Usually Clients+Apps, this contains 
all personal client information and policy information. 
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Figure 4: Reports/Select Table 

 

4. Click OK.  The user will receive the message, “Type the Title you want.  Fields are pre-selected for 
you.  To maintain maximum speed retrieving data, remove fields that you are not going to use.”  Click 
OK. 

5. Type in the Title of your Report. 

7. Select Tables 
 
Clients and/or Genappinfo will automatically be selected.  Additional tables can be added to the 
report.  The most common tables that agencies use are:  
 
Clients – client name, address, phone number, status 
GenAppInfo – policy number, effective date, expiration date, premium, policy status 
CompanyList – names of companies 
Producers – names of producers 
 
However, any table listed under Tables Available can be used in a report.  To add a table: 

a. Click on All Tables under Tables Available.  This will provide a list of tables. 

b. Highlight the table name 

 

 

c. Click on the Add Table to Selected.  When a table is added, it will display in the Tables 
Selected area. 
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Figure 5: Select Tables 

 

7. Add Fields 

Certain fields will be pre-selected.  Fields are selected for two reasons.  They are fields that the user 
wishes to see displayed on the report or the fields help define the search criteria for the group of 
information that will appear in the report. 
 
Remove fields that are not needed by highlighting them under Fields Selected and clicking on the 
Remove Fields from Selected button. 
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Figure 6: Removing Selected Fields 

 

Add any additional fields needed by highlighting a field in Fields in Table and then click on Add Fields to 
Selected. 
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Figure 7: Adding Selected Fields 

The field listed at the top of Fields Selected will determine the order in which the items will display on the 
report.  For Premium Volume by Client use ClientRef as the first field, Name could be used but it is not a 
unique field as some clients have the same name.  When doing a report to find how many people live in 
each zipcode, move Zip to the top of the list.  If doing a report to see how many clients each producer 
had, move ProducerCode to the top of the list. 
 
GenAppInfo contains a special field called PolicyCrossRef.  This field allows the user to cross reference 
two policy types on the same client.  For example, find all clients who have an auto and not a home.  If 
you were trying to locate all clients that have a specific policy type, you could use the field called 
PolicyCode. 

8. Click OK to continue to the next step. 

9. At this screen, the user will define the group of clients that will show up on the report.  This may be 
referred to as the retrieve spec. 

Common retrieval symbols: 
/  means NOT 
=   means EMPTY 
/= means NOT EMPTY 
;    means AND 
:    means OR 
>    means GREATER THAN 

<  means LESS THAN 
..  means wild card search.  Search on partial information such as ..christopher  
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Date retrievals: 
>=01/01/2008 <=12/31/2008  
{TODAY}  
>{TODAY+30} <{TODAY+60} 
MM/DD/YY means current month, current day, current year 
MM/../.. means current month, any day, any year 

Two fields that should generally be considered are the Client and GenAppInfo Status fields.  
These are two separate fields.  A value of A stands for active. 
 

 

Figure 8: Retrieve Request 

 

10. Click Open Report to design the layout. 

Groups 
Groups allow you to calculate a subtotal for a “group” of data.  In the example ClientRef will be the 
group used to determine how much annual premium and commission is earned for each client.  
Groups also allow the user to “group” information together.  To create a report of all clients for each 
producer, use ProducerCode as the group.  Usually the group should match the first field of the 
locater because it also determines the sort order. 

 

a. Click Report->Groups 
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b. Select a field that defines the group.  To get a subtotal for each client, it would be 
ClientRef.  To get a subtotal for each agency, use SubAgencyRef, if the user wants a 
subtotal for each producer, select ProducerCode. 

c. Click Add 

d. If you would like it to page break between subtotals, put a check mark in Start new page. 

e. Click OK 
 

  

Figure 9: Add a Group 

Headers/Detail/Footer/Summary 

Headers are the area where labels for fields in the report are generally placed.  Information that 
should only be seen once in the report can also be placed in the header.  For example, in the report, 
the client’s name doesn’t need to be seen next to each policy, so it would go in the header.   
 

Detail is the body of the report.  Place the fields across the page as they should appear on the report. 
 
The Footer is generally where calculations that subtotal information for a group should be placed. 
 

The Summary is where a calculation to get a grand total of all of the groups would appear.  To add a 
Summary, click Report->Summary. 
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Adding/Deleting Fields 

Fields will automatically populate into the Detail band on the report.  Fields can be moved simply by 
clicking and dragging them to the location preferred.  To delete a field, highlight the field and hit the 
delete key on the keyboard.  To add a field, click on the DB Text button.  Click in the location where 
the field will be added on the report.  This will create a DB Text box.  Then select a field from the drop 
down to use in the DB Text box. 

 

Figure 10: Adding a Field 

Adding/Deleting Labels 

Labels generally appear in bold and can be moved by clicking and dragging them.  To delete a label, 
highlight the label and hit the delete key on keyboard.  To add a label, click on the Label button.  Click 
in the location where the label will be added on the report.  This will create a Label box.  Then type a 
label description in the text box above.  To edit an existing label, highlight the label and edit the text in 
the text box above. 
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Figure 11: Adding a Label 

 

Fields containing decimal points are best displayed using right justification.  Click on the field and 
click on the Right Justify button on the toolbar. 

 

Figure 12: Right Justification 

Calculations 

Calculations give a sum or a count of a specified field.  Calculations should be placed in the Group 
Footer and the Summary.  To add a calculation, click on the DB Calc button.  Click in the location 
where the calculation will be added on the report.  This will create a Sum box.  If you would prefer for 
it to count records rather than add, right click on the field and left click on Calculations.  Select Count 
from the Calc Type drop down.  Finally, select the field that will be added or counted from the drop 
down box above. 
 
In calculated fields that contain dollars and cents, right click on the calculation and left click on 
Display Format.  Select a format that will show the value with a decimal point and click OK. 
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Figure 13: Adding a Calculation 

 

11. Click the Preview tab to view a print preview of the report. 
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Figure 14: Report Preview 

 

12. Click the printer icon to send the report to the printer. 

13. When exiting the report it will prompt to save the report and retrieve request, yes will save this report 
for future use. 

14. The report can be printed from the Preview tab, or after executing the report by selecting the Print 
option. 

How to Modify a Report 

There are some Custom Reports in the Reports section that can be customized and used for agency 
needs. 

1. Run the report. 
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2. Click Modify Setup to add/remove selected fields (see the Creating a New Report section of this 
document for directions). 

3. The retrieve request can be modified for different report purposes(see Creating a New Report). 

 

4. The Design tab will modify the report’s appearance and Preview shows the print preview. 

Report Security 

Security can be applied to individual reports.  When the system is updated to version 9.1, all reports 
will be available to all users until security is set by a level 1 user.  Only a level 1 user (Administrator) 
may set report security.   
 
Changing Report Security 
 

» Report security is available at the top of the Report screen under Tools->Setup Report Security. 

» The administrator will see a list of all reports by category and a list of user names that are allowed 
to use and reports.   

 

Figure 15: Setup Report Security 
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» Highlight a report and click the Set Security button  

 

 

Figure 16: Authorized Users 

 

» The names that are checked have permission to run the report 

» The plus and minus button allow the administrator to check or uncheck all names 

» The administrator may also check and uncheck names individually 

» If the administrator wishes to apply the same security to all reports, place a check mark in Apply 
To All Reports 

» Security settings can also restrict users from creating custom reports (this option is listed at the 
top of security screen) 

 
When the administrator has removed a user from the list of authorized users, the report will still appear on 
the user’s Reports screen, but it will display with a red link icon and the user will be unable to run the 
report. 

 

 

Figure 17: Not Authorized to Run Report 

 

When new users are added to the system, they automatically have access to all reports until the 
administrator removes them from each individual report. 



 
           

FSC Manager 
Reports 

 

 

Page 24 

© Vertafore | 26650 W. Mondovi Street | Eleva, WI | 54738 

 

 

Obtaining Support 
 
 
If you have any questions about this training, please contact FSC Customer Support.  Thank you and 
enjoy using FSC Manager! 
 
West Coast Customer Support: 800-433-2550 
Midwest Customer Support: 800-401-2895 
Email: fscmanagersupport@fscsolutions.com 
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